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Annotation 
 
          The thesis provides a comprehensive system of automation of the seller 

of computer equipment online store. The paper presents the structure of the database 
of buyers and types of computer equipment. 

          The effectiveness of this program automates the workplace of the 
seller, making it easier and save time.  This application is created in Visual Studio 
and a separate file is created using the MySQL database. 

          This diploma project provides for the introduction, study of the subject 
area, development tools, design, applied, economic calculations and labor 
protection. 
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1.2 Кі і  і і  ұ  
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2- . ң і  .  
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,  ң і  ң . 
ң    ң і і    
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2- :  і    – і   і  
 і   ің . 
 3.  і   і і   ң . 

   -   і і ің  
  і    . 1 (1NF)  

і і і і іңі ,     IBM Cognos 
Conference   і і  і: 

 і і і  і і і   і і і  і  2- і і  
і і  (2NF) ң ;  

 і і і і  і і і і  і   3  
і і  (ZNF) ң ;  

 IBM® Cognos   і і ің 
 Boys   і і і   і і  і. 

і  - ң   і і  і (NFBC) 
і     і     

 і і і  .  NFBC-   
,   ң     

 і    . 
4- . « і і »  ң .  
і  (  ),   -  і  

 ң  і  ң і  
і  .  і і і  і, і   .   
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- і  і ің і і і і і  і , 

 і    і і і. 
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і    і    ң (  і ің) і 
 . 

ң  і  і     і і  
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 і  і і    і ің   
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і   і    і і і  . , 
  і  . ң і ң і  
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ң    ң  
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і      ( )   і  

  і  . 
 і   і   і  і   і   і – 

і    і  і  і і.  
ң і  .      
 і і   і    -   
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і (   );  
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2 Ж  і і 
 

    і ң   
 і і   і .  і  

і  і    ң  . і і   і 
 і  UML і і  (Unifed Mideling Language)   і і.  

UML  і   і  і і-  
  і  і    і і  
і, і і ің  ң     

   . ң   і 
  . і  і   і   ің 

і ң   . 
 
2.1   ұ  

 
  ( ң )   

 (  ) і і.    
   ( ң   

  ). 
      і і 

ң ң і і і (    ) .  і 
  :  

 і і  ;  
  ің  ;  
 IBM і    ;  
    і     ? 

   і  і  :  
  ің  і   і і і  

 і і  ің     
 ің   . 

 ,     і , ң   
і   і    . 

    і    
  і .   і 

і,  і і і     і.  
  і  і  ,   і і і  

 ( ,  і)  і    
 і .       , 

   . 
і і   5 ң   і .  
 ің і  і  ң  

   і іңі     
  . 
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   і і  . і  
ің і     і   іңі   . 
ің і ң -    і. 

  і  і і  . ң , 
і      і і   . і  

   і   і   і  
   і і   .   і  

   і   і.  
     , « »  

« ң » ң і і .  ң 
і і і і    , і  і  , ң і  

.   . 
« і    », « і   

і   », « і  ң і», « », 
« », « » і      і  

. і   і і,     і  
 і   .      
 ,        

  і .       
,    . 

 і ің  і і  і і і   
 ң -  . ,   

     ,    . 
ң  і  і  ң і і і  

     і     
 і   . 

 і ің  і   і  
ң , іңі і ң :   
  ;   
  і   ;   
 і  і  ; 
 і; 
 ;   
    і ;   
  ;   
 і і ;   
  . 

  2.1-  і . 
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2.1-  –   
 
2.2 Ті    

 
і   ң  ң і і і   

 і.  і і    і і  
 і і.  і   і,  x 

 і      і. 
 ің і і і і і ің і   

 і  і.   і ің і і і    
   ң  і і  і і  ің 

і  і.       . 
і ң    і ің і і ң ң ң 

  і  і і.    
 і і. і     ң   

.   , і,   
   і - і  і  ,  ң 
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і  і і і  і і і,     і   
і. 

 і   і і і   і і і і   
ң . ң і і   і  і і і .   

 ,  і і і. і і   –  
ң   і   і і і  і  

і і. 
ің     і (  і ің 

 ң )  -  ің і   і  
і. і і  і    

 .   ң  і  
і ің і і  ң і і і  і і.  

 і -      
і  . 2.2-  і і  , 2.3-  

  і . 
 

 
 

2.2-  – і і   
 



30 
 

 
 

2.3-  – Ы   
 
2.3 К   ұ  

 
  (Class Diagram) і і-  

 ң   ің 
і ің    і  .  

,   і ің ( і ің)   
і, ң і і     . 

2.6-    ң  « і і » і  
  і  -    

і  .  ң і і    
. 
      « ?» і 

 і.  і і  і  :  
 ,   ің  ;  
  ң  ң і   ң   

( : , ,    ң і і 
 і ). 

 ң і . і     
 і.   ң  і   

 і і. 
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      ,  ң 
і і ің і і. -   і ің  ң 

 . ң і і  і і  і ің 
 .  і   ң і і ің і і і 

. ң   і   , і 
 і і і і   .   

і    .    
 ( ) . і і  , 
і і  ң :      

; ң  ң і  і .  
:  і ,  і , 

 і  -    , і і і   
  . . 

і   –   ң  і і. 
  і  ң і   ң 

 і   .  
ң і і і і :   

 і і ; 
 . 

  ң ,  і   
  і і. 

   і і і   і :   
 ң  і  ң 

 і ің  і.    
    і, і   і  і  

і  . І  і ,   і   і  
 і       , 

 і    (   і і )  
 і .   

 і і   ң і  і, і   
  і   ,   (  – 

 і і    ); 
 і   і  і      

.  і   і   ң . 
   ң , -  

 і   ң . ,  і і ің  
  ,  і і    

 і і і  . 
  , і  і  і ң ң  .  і  

   ,  і ің ң  
  іңі  . UML   –  і  

 і  ң і і , і і,    
 . UML      

 і . і  і    
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 і    , і і  
ң .  ң      

 і. 
 ң    .  

 , ң , і  і ң 
 ң і   і і і  

 і і. UML і    і : <visibility> 
<name>: <type> = <silence>,  і і - ң  і   

  і.   і   .  , 
  і і  і і  і і  і. 

  і   .   
  і     .  

і і і ің ң і    і    і  
 і.     і   

  і, і   .  
     ң і і і і  . І   і і 

-      ң і   . 
   ң і і : <visibility> 

<name> (<parameter list>):< і    і> {<property-string>} / 
 і  і і  ің і і   :  
 «+» ( ), «#» ( )  «-» ( );  
 ң    і;  
 IBM Cognos  і і і і  і   

і   і    ;  
    ің і  і   
  і і  ;  
     і   ң 

і  і. 
ң і  і     

і  і      . 
  і і і   і  ң і  і  

   .  і    
      і   

і .       
. 

 ,  ң  
 і.  ң і  і .  ң  

і   .  ң      
     і. 

 ,   -   ң 
 і   ң  . «*» і і « і  

і і »  і. 
 і  ң : «1», «*», «0..1» (  , 

).  , і    ,  
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   і .   
і і і ң і і і  і. 

 і і ің     ,  
і ің    . , і  і і  і  

і  -       
і і і і   -  і і ,  
   ң  . 

ң і і ң і  ң і і і 
і  і ің  і   

і . І і і   і  . 
І        

і і  і   .  
 і і  ң  і і   . 

і і і  – і - і    ң    
і і ің і і.   , UML   

 і і і і  .   і    і    
,  і і і   і , і і і  і, 
  .  і   .  

 2.4-  і . 
 

 
 

2.4-  –   
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3 Жү    і  і і 
 
3.1 ғ  і і  ң  і  

 
   і  і   ң  

   . ң і і і –  
і  ң      

і і. 
і і і  ң – ң  .  

ң  і і   і  і     
і і і і ң  . і і  ң 
 і  , . .,    

.   і     
 і .  і і  і   і  

    і і  . 
і і   –  ің і і   

  і  ,   і  ң 
і і  . і     і  

і і  , ң і  – ің і і і. 
ң  і  і  ң і,  і 

  . 
   і       
. і  , ң   ң ,  

 ң ,  і      
  ң  і  і   -

 і  . 
 і ,  і і  і 

ң і  ң  ,      
і    і і  і  , , 

 і і і  . 
ң і і  - і і  , , 

 ,    і і  і  
.  ң  ң   і і і і  

 ,     ң   
 і  .   і  і , і   , 

 і і  і і     ің 
    ң  . 

 і  ң   . 
і ң  і :  
  і     і : ің і 

   ң    і;  
 і і  і  і і  ;  
   ің і  ;  
 і  і і   ,  ;  
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 IBM® Cognos Express    ң  
і  і  ң ;  

 і ң     ;  
 і і і і . 

ің і і і і   і і  – ң і і і і. 
  і   ің і і  . і і 
   Visual Studio   C# і і  

і  ңі  .     і 
ң і     

 і  і  і   і   і і  і. і  
  і  і  Visual Studio   

. 
 
3.2 Visual Studio   

 
  і     і і 

і і  , , ,   і    і  
Visual Studio   . Visual Studio ң 

   і   і  : C #, VB.NET C ++ 
 J #, і  і і     і і   
і і. 

Visual Studio і   і  і   , 
:  

 IBM Cognos Analytics і Windows  і  
;  

 і Command Processor і  і;  
      (dlll 

і);  
  - ,     

  . . 
Visual Studio ң  і і Windows   -

   , і  і і  і і  
і   і і. 

 і     і ңі ,  
Windows   і   і і   і   

і і    і і,  Turbo Pascal . 
«   і   і  ң , і і  

  GUI і   .» 
Visual Studio   і    

ң ,  і   ң ,  ң   . . 
, Visual Studio  і , C # і і  і . 
і і і    і  Studio.NET   і  

Visual, File -> New -> Project і  ң ң  . 
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 і  і ің   Visual C # Windows 
і і  ң   і і ің ң  і і   

 ң . 
 і і     , і      
. ің    і і ң  

і  і іңі  ( і    ). 
 і   і ,    . 

ң і  3.1-  і . 
 

 
 

3.1-  – і    і і Microsoft Visual 
Studio ң і і 

 
3.1- ің   і і і  і і (  

і, ң , і і   . .).   і   
  і   ң  і . 

ң  ң   Project Management Solution 
Explorer і (   і , і   і  і і і і  

ң  ). 
 System, System.Data, System.Volume  Xml  

ңі і і   . .      
. 

ң і і і і    ,  
     ( і )  . 
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         і 
і  . 

  ңі , і ің і 
.  і і  ( і  ) і і   
. і і    - ,   і і  

 і і. 
і ің   і        

  ң   . -   
 ң , і і ң і ( )  ,  

« »  .    і , ң і і і 
( ) ң і і і і  « » .   Windows 

і      і  
ң і    і і  і. 

і  і і   і   ->   
( і  і і  )   і і   

.  ->  ң ,    
і і  і    ң   cs і і  

і   і і  ң ң . 
  і  File -> Open Project  ң . 

ң     і.  
  ң і і і і   і  

, ң     і і і і і і  
    і  і і  

і.  ң і і і і і – і   
    ( ),   

 . Windows   ( і 
  ) і і-   

 і  і. Object-Oriented Programming (OOB) 
   і   

 і:  і   і. 
і   – Windows ң  і і. 

  і     і  
і  і       

  . Windows CBS-   і   
 ,  ің і і    . 

ң і і і і   і  
 і і  ің ң    . 
і і ,  –  і. Windows  

і і-     і і і    
 і . « ің  і і і    і 

ң і і і і  і і,     
і  ,  –    ң 

 і і і   . 
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 Windows   і   
,  і   і ің і ің  
 . C #  і     
 .  , ,  

,  і    і і  
, і   ң  .  ің і і 

 і і   і і   і і. 
І і   і  і  ң   

.     
 і   і ің   

 і. 
  Main () і і ің   

 і  . Windows і   ң 
і і,  і   і , Windows-   

 ің і   і. 
 Windows і і  ің   

   .  і , і   
«  » , ,  і , 

ң і ,  і , . . іңі  . 
Windows і  і   і -  і і , і  

  «   »     
і    . ,  

ің і ( , і і , ). 
   Windows ң « і і »   

і і і .  і -  « ң і», Windows і  
 і і. 
Windows і   і  і .  

 Windows і     і  
і ,   ің і    

і   і  і   і. 
Windows      . , і  

   і ің , ң 
 (id)   ( , x  y  ) 
   . 
 
Windows     і  і    

 .  і ,   і    
Windows ң і  .  , і  

 і    і .  і  
і   . і      

, -  і і  і і і і . і  Windows 
 Windows і  і   ң   . 

    « і ің» ң     
ң і і  ң і і  і і. і   і  
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і ің  ң  і     (  
    і і). 
, , і і  – і , , і   

. .  Windows ң  і   B. 
  і    і і ң , 

і і     і  . 
 ң   . і  :  

       
.   і  і   Windows 
 і    і ің і  і і. 

Windows і    (  -> ң  ->  -> 
Windows Forms Application) і і і і : і і , . 

   :  ң  і 
Application.Run ();  Main () і і  і  ,    

і і і     ( )  
. 

і і    і  : і і  і  
,     (Form1.cs 

). 
 
3.3 Ф ғ  і  

 
Windows   і і  . 

і і і ң –  і і    
ңі. 

і і ң , ң  ң і і ің  ң  
,   Windows і      

. 
Visual Studio Windows  ң   
 і      (File -> New -> Project -> Windows 

Forms Application), 2.2- .  і   ,  
  ң  іңі  . 

System.Windows і і   і і  ңі і і   і  Form1 
і  .  і   і  F5 і  ң   Debug 

ң  і і  ң ң . 3.3-  і   
ң і  і. 

Visual Studio   Windows і  - і 
ң . 
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3.2-  – Visual Studio  
 
Form1 і ң і ң  і   4 

ің , , Form1.cs [Design] і і  і  
і    Program.cs і   ң  і  

. 
 і  і ің  .  

ің і ,     . 
 і і і (3.3-  і ,  , 

 і і ) – і ің іңі і, і  і  
 і  і  . 

 

 
 

3.3-  – ң  і 
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Toolbox і (3.2- , , ) і  і  
. 

Solution Explorer і (3.2- , ң )    
 ң  і і  і.       

 і і  і. 
,   і  ің  і і  

    і  . 
 
3.4 Ф    я  

 
Windows і  . Forms.Designer –  

і і і і  і     
 і і  і  . ің  ,  

і  і і       ң 
і ің  і    , , ің  

і,  і. 1-  і і    1-  
  і і   і  і і   . 

Windows  (   ), 
  і  .cs  Form1.cs  Program.cs  

ң і   . C # і   і  і  
, ң  і  і і і  . і  ң 

 і   і і    і і 
ңі і. ң і  і і     . 

, ң  і  і   Form1  . 
Cs-Form1.cs ң і і  і   Form1.Designer.CS . 
Form1. «Cs»   Form1 і і ң і і і і і 

    і і   ң і і 
. ,    і і   і  

і і    і і   
 , ң  і  і  Form1.extract cs 

: 
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Form1 ң і і і і, «Form1.Designer.located» cs « . 
ң  і і   і і і  . 

і , і  і і і і , ң 
і  і  ң  , і і і 

,  і і і  і і ің і - і  
 і і     Form1  ң . 

Form1    і  і і  і і ің  і 
ң і . , і  ң    ң  

  і іңі  . 
Cs  Form1.Designer.extract  і : 

 
    . Cs  

 Main () і і .  , Windows і і () 
і і  і і    і і і. і і () і і  

 і  і  . 
 cs ң і і і  : 
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  Main () і і ің і і і і  , 

   і і і  і . Windows  Main () 
і і і і     і і  

і.    Main () і і  і і? FCL 
і   і  і і  ң   і і  

   і і.Application. 
The EnableVisualStyles () і і Windows XP і    

 . 
Application.SetCompatibleTextRenderingDefault ( ); і   – 

GDI +, false – GDI  і   і  . 
Application.Run ( ң  Form1 ()); і  –  ң і і 

і і  Main () і і і  і . 
і і  Run і і   , ң  і  

Form1     ң  -   і 
.   і    ң, 

Windows ң   і і  , Windows 
і   і  .   , , і 

і  : і і  і і  і і іңі . 
 
3.5 Ф  ш ғ  ғ  ғ ң ң іш і 
 

    і і і  ң .  
   ң і  . 

   і   ң і і   і  і  
OpenFileDialog і .  ің і і    

і  і іңі . OpenFileDialog і ің і і і і ің 
  і і. 
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3.4-  – OpenFileDialog і   
 
OpenFileDialog і   - і , 

і і,   і і  і    
.   OpenFileDialog1.The ShowDialog і і  

 і ің і і -      
 і і    і  .  

  ң  і  і і і. 
OpenFileDialog1 і ің  ң  і   

ң  і і  .  і  openFileDialog1 
і ің c  і  c і  іңі  .  

 і і   ң : 
Text files|*.txt|RTF files|*.rtf| All files|*.* 

і  «|» ң  і  і  . і і і і  
 і ің  і і   і  і,   і  

 ( )   і і і. і і   і  *.used 
 ( ) txt. 

 і  rtf ң  . RTF  
*.bulkhead ( ) rtf . 

ң   і   і  (  ) *.* 
 ( і ) . 

  і  і і    і і , і   
 і    . 

ң   ң і і: 
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3.5-  –  і     
 

  і  і і    і і , і   
 і    . 

   ң  і і « » і  
ң , ShowDialog DialogResult і і. OK і  . і і  

 ң ң  і ( ң    ң 
 openFileDialog1.FileName.Length  0-    

і ). 
File richTextBox1.When LoadFile і і , і   

і і. і і і  - ң ,  і і  –  і. 
і і    і іңі   , і і і – 

RichTextBoxStreamType.PlainText. ң  ң і і і LoadFile 
і і і PlainText і і і   , System  

ArgumentException і ( ) .   RichText 
 і    .  і RTF   і. 

  і   ң   і і  
і  і і. 

   і  (Save і)   
 і  -  і і .     

ң і  . 
     і  і  

SaveFileDialog і .  ің і і   і 
і  і і  і  і іңі .   SaveFileDialog1 
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і і і і    .SaveFileDialog1 і ің 
 ң  і , і     ң іңі  . 

і  і  і і   і    – *.txt і і  
. FileName  document-doc1.you  txt і   

.    . 
ң   ң і і: 

 
ң   і і  і  і і. 

RichTextBox1.SaveFile і і ің і і і  
ң і  .     і і   

 і  . RichTextBoxStreamType.If і RichText 
і  і ,  RTF і і і  . 

 

 
 

3.6-  –  і і      
 

  і   і  і , і і  
  і   і  ң і і . 

і і    ,    
richtextbox1 і і  ң і і ің і і . 
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і і і і      

   і  6 * 6 ң (   
) і  ң  і  . 

і  ң  і і ің   і : 

 
 і  і і   . 
,     ң  , c  і і  

    і  ң    
ң  і і і   String і  і : 

ss = richTextBox1.Text; 
clova = ss.Split('\t',' ','\n'); 
clova.Length – і і  ің  . 

 2  3 ң  ң    і   
  Masi і   .    ң 
 і      (  і ). 

 ң ң  і і   ң  і   6 * 6 
 . 

   і    . 
 і  ң  і   ң . 
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3.7-  –   і і і  і  
   

 
3.6 Protected  Private і 
 

і  і  і і і   , і  : 
public, private, protected, internal.   і і  і  

   .    
 і , .  і і   

     і і  ( , ) і   
і  і і  і. 

 і  ң  і і і   і і і  
іңі .   і і      

,  і    ,  і  і 
     і і  і. 

 .   ің 
 і і  і  .  A ң 
  і і ,   B і і  A 

ң і   і , і   і   і  
.І і . і     і  

  .  A  B    
( ) і і ,     і   

 .   ң і і і  і і і і  
,  A і   B   і  

і і  і  і   і  . 
  і і ң ( ) і і.  

   і і   і і    
ң  .  і   і і ң і  ң ,  

  і і     і  , і і 
ң і  і    і і  

 і  ң  .  і    і і 
і   і і ,     . 
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 і   і   , і   ң і і 
    . 

 A ң і  і і A  і B і і   
і і ,   і   і  і   

.  і   і   .  і  і  A, 
B1, B2, TB і  і  ,    

і і  і і  ,  і  і і  
ң ,    і   ( ) 
 .  і   і  і   . 

,  і  і  B ң   і і   
і і  (B ),  і     . 
 і      і   . 

 
3.7 і- ғ ғ  ң і 
 

3.7.1 И я я ұғ  

 
і і-     і і 

 і : ,    
. 

 ,  і   і ң   
ң  і і  і і і   ң і і  . 

  – і і  і і і   і  
ң і і і   і і. 
 і і   –    

 і   . ң і і   – 
  (« » і )    

. 
 
3.7.2 Мұ і  ұғ  

 
і  і і-   

 і і   . і ің  
–     . 

і   ң і   і і  
     ң  

і і: 
 –   – . 

  ң і   і і   
    ң   

і і і: 
 – і і – і . 

 і і  ң  і  
. 
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« і і    » і і і   
і і  і і  і – ,  і  і і, . .  

  ң і і  « »   
 . 

«   »  «   » і і 
і і       

, , DELPHI-  VCL, VISUAL ++  MFC  
   і , C# і і   ңі і і. 

і  і і      
. 

і  і і      
   . 

і     і , і , і і   
 ң і , і , і і   і і і  

. 
і   і і  і  і  . 

      ң    
  і і і     . 
  ң і  . 

і і і і   і    ң    
і і ,  і і і  . 

і і і       ( ң   
) і і   . 

    і і ің і і   
 і і і    і.    

        
, ң і і і і  . 

і     і і  і, 
     ң і і , 

і , і і   і і і       
 .  і   і    і і  

і.  ң  ,   і ,   
  ң  -  і  і   

. 
 ң     

ң і  ң   і і . 
 ң     ң 

 і і . 
C# і і  ң  і і ің   – 

System.Object. 
і  і і і-   

 і і   . ң  – 
   . 
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і    і   і і і ,  
  ,  ң  

і і:    - ң і. 
      і  і  

 -  і і     
і і і: Point-segment – і . 

ң  і і і і  і і  . 
« і     і » і і і  ң 

 і і ,  і     . . і і  і.  
   « і »  і і  і  

 і . 
 , , DELPHI, VCL, VISUAL C ++, MFC   

 і   і  ,  ңі і і C # -  
. 

  і       
. 

  і  і і     
  . 

   ң і , і , і і   
і і  і   і і  і. 

і   і і  і  і  . 
  і  і     
 і і і   ң  . 
  ң і  . 

і і і і   і   ң   і    
і і і   . 

і і і   і  ң   ( ң   ) 
і і   і і . 

  і   і і  ,   
і і і  .     , , 

  і  , ң і і і і  . 
і     і і  і, 

    і ің і і і   
 і     і і , і , і і  

  і.     і   
 і і  і. і і   і і ,   

і , і і     і  
 . 

 ң    ң 
і і і і ң   і і і і. 

   ң  і і і  
. 

C# – System.Object і і і   і і ің і і 
. 
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  і    :   
   і і і    ;   
   ңі ;   
 і     ң   

 ңі  і . 
,     і і , і  

і  і   ң і  . 
 ң  і і і    ң  

    :  
[  ] [  ] class _  [ :   ] 
{  і} 

  ң  і ,     
System.Object  і. 

 і     ,       
, : 
public clas otr : tka 
{  і} 

  і   і   і і. ,  
tka    і   і і і  і і  

,  -     . 
і       і  

і . : 
protected int x; 
protected int y; 

    і і    
і і ң (public specifier)  і   . 

і і ,    ң  і  
і   ,  і    і і і і 

 і . ,   і   
   і і і.     

      .   
 ,   ң     

і   . ң  і і    
.  і  ң   і ң  , 

  і і  і і     і   . 
   і і  – і ің   

  і   і і і  . 
 ң і і    і і і і ң 

 і і  , і і    і 
 і і   і і   і   . 

   ң  і і  ң 
  , ң   і  

  і і . 
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 ң   ң  
і   ,   ң 

  . 
 ң  ,   

ң   ,  і   ң . 
   і і :  ң 
      і. 

 
3.7.3  ұғ  

 
ң   і    ң 

і   і і   і і  і, і   і  
і і:   і і  ( і ің   

 ). 
  – і ,     

     . 
     – і  і  

  і  . 
 –   і і  і  і і . 

ің і   і   і  
    . 

і   ң  . 
   і  ODO і і і   

 . і і  і ің і і і  ң 
і  ң ің   і і , і    

   і . 
, і        

   і і  і і   . ,   
  і   ,   і  

  і   . 
   і і  і    ң 

 ,   і     . 
і       і   . , 

 і ің   ,   і   ң 
і  . і   ң  і і 

    і   (  
    і і і ң  і  

). 
    і  і  
,   і   і  

 і   . 
C # і і  і  і   і    

 . : 
virtuual publlic doublle ploc() {return 0.0;} 
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   і і  « » (« ») і і і.  , 
 ң і і і  і ің 2000  25 

  і і    і і і і , 
-    і і і і    

ң ң   № 648,   і і і і ің 
  , ң і і    і і і і  

і    і.     
і   і і  . 

  і і  і   
і ің   і  і ің    
і  і  (VMT)  . і   і  і   і  

і . 
 ,  і   , ң  , 

  VMT і  і і  і   . 
  і  і ңі ,      . 
,  і і   і  ң  

і і   і       ң . 
   і  ң  і і    

,  і     і   
    ( ) і і  . : 
publiic douuble plooc () {. . . }.  

і   і   і і ң і .  і  
  і і  , і   

. 
 і    -  і і   

 і і  ң ,  і  і  і і і  
і    і  -  ң  і і і   

і.   і і   і і  і і  
ің    . 

  і     і і  
 і і   , « » (« ») і . 

  і   ң    і 
і і    . 

   і і і  ң 
і і і   ң і     
 і   і і і. 

 і і і  і « і » і і і і,  
  «  і  і  і ».  ң  

   і  ,   і і  
   і   .  і  

ң   і  ,  і   
і  і   . 
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3.8 К  ұғ  

 
C # – і і-   і і. ң і і 

 – .  і  C # і і    
 . 

C #  і   . 
 .   ,     

і     і  [1]: «  –  і,  
ң   - і  «  ». A. .  
 [2]: «  – ң     

ң ң   і   
 і і ». 

 , C # і і  і , CBB     
і ің і  . і     ң   

і : «  –   ». 
  ң  ң  і і – , 

і     ң   і і . 
,     і    і  . 
  і і ң   – ң ,  

   ңі   . 
 – і , і      і. 

 і – ң     ң 
і  і    . 

   і і, і     
    і і і. 

і   і і і  ң ң і і   
 і, ,  .    

 .   ң   і і і. 
 ң  ң .   
,  і   і , ң  ,  

 і   – ң і.   ң ң 
 . ң   і  і і 

(   і   і ):  
[  ] [  ] 
class ң_  [ :  і ] 
{ ң_ і }  

   –     і; 
 –   і   :  

 ің  і ( - ) –  ;  
   і ің  – ң і  . 

  і  і  і ,   
.     - і . 

, ,   і і   і  
ң і і і і  .   ң і і  
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  ,     
ң   і і  і ( і і ). і і , 

 і і і і і   .   
    і і .   

ң і і  (  ) ,   ң 
і   і і  і. 

     , , 
і , і   . 

ң і і ің і   і і і  
. 

 і і і   « » і  ,  
 і ің  –      і. 

  і і , ң і  
і , і   і і і. 

ң  ңі і і      і . 
ң   ,     . 

C#- ,  –  і  ң  
ің   і  ң    . 

 
3.8.1 К  ұ  

 
   , і    

 і .   і   і  . 
ң і і і   ң  

:  
 ң  і  і  ;  
  і  (  ң і  ));  
  і і, і і і   ң  і,  

і   і  і  ; ң і – ң 
і і ің і   (   ) і   і і  

і  і  ;  
        і і  

і  і    і і  ;  
 ң  – і  і    

і і;  
 і і і   –   і   

  і    і   
і ;  

 і і , , , ,   
 і.  

indexer – ң  і   і  ; 
 ң і і     

і і      . 
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 і ,    ( і )  
і . і  , , і   і  і і , 

: 
private int a; 

 і   і     і і і 
 : 

[  ] [  ] 
[ const ]   [= _ і]. 

,  і і «  » –  
 .  FA і   ,  

     . 
і    і  і    
. 

 –  і ің і    
    і ің . 

    і     і  
    і .   

і   і  ,   і і  ң 
і  ,  . 

і   ( і )   і і   
і    і  .   і  ,   

 і  , ,  і і і  і і  
 і  і  і  ң : stud.name = ivanov;  і , і  

ң і і  ң  і , , stud.poisk (a),  poisk (int 
a) – ң і і,    ң  і . 

  . І і  і   ң    
  . І і      

і   . 
 
3.8.2 К  і і 
 

і  –  і   і і   і  і  
     . і   

 і     ( ң  
і   ). і   і     і  

 і  і    і . 
 і і      і : 

[  ] [  ] і  і і ің  ( [ 
 ] ) 

{ і ің і} 
: 

static void Main(string[] args) 
{ } 



58 
 

ң ң  і  ,     
. 

   ң -  і і   
ң і і і   і і . 

   і і ң   і і  
 і і  і. 

     і і «  
ң і »  .   ң , і і   
і і і . 

і і   і і і    ,  
 (   ) . 

 і    і і  і    
і  . 

 і   ңі , ң  
і і    . 

і ің і -   і    C# і і 
і     і   і . : 

int kol(int a) { … } 
public double sym(out float r) { … } public void poisk(ref float s) { … } 
public int funkcij( int a, out int b, params int[] c) { … } 

   і  і і  (   і  ),  
і  і ің ң   і і  і   

   . і    
   і   .  і  

  . 
 і    і , і    

 ң ң і    ( і  і  
  ).  і   і   . 
  і - ң . і ің  ( ) 

і ң , , , ,   . .   
. 

і  і (  ) і     
  і  .  і і  і 

« » і і  і і і. 
C#-  і і  і :  
 і   ( ің і,  і  

 і  і);  
  і (  ));  
  ің і (ref- і  і і);  
   («params»   і і).  

 і  і  і.  і і ің 
і і  і і. і  і   і   

і і і і ң    .  і  і  
і  ,   і  і  ң 
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і  і ің і і   і. і   і ің 
і   , і  ң  ( ) і і  

. 
і   і  і   

ің  . 
і ің  і   і  

і і і.  ,  ің і  і  і і і  
, і  і ң  ,   

     . 
 і  і і  , і  і і 

ң -     і   
  ( ң  і   ). 

ң -    і  і  і  
  і -     

 і  .  , params  і  і і  
 -  і  і  ң і і і. 

, і  і і  ( і  
 і  і)  і і  

і  і  ң ң і  (    
 )  . 

і ің  і  і    
. і      і і  

.   і  і   
ің   ,    і  

і ің  і  і і . 
 
3.8.3  ұ  

 
    . ң   

  ің    . ң  
  ң . ң   і і 

. 
ң     ің ( і ) 

 і і і ің -  . 
 і і  і і       
. і   і і  і  ң 
і   і  і  і   . і  

  і  (   ң  
і  ),  і ің і   і  

і і   і. 
   і   і   і і ің 

і і     і і  і.  і і   
і  . 
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ң .   і   
  ,  ң  ,   і  

 , і   і і і     
 і і.  і  , і і  

і і   і . 3.9-  ң і і 
і  і. 

  і   ң ң   і і 
і   і і іңі і  . 

 і і і  ң  і 
. ң і і    ң 

і і і і і  ң . і      
ің   C #   . 

  і   ң  
 .   і   ң 

ң   і і і   і і іңі і 
 .  і і -  

і   і і  і . ң і і 
   ң і і і і і  ң . 

ң  і    
  , -  і і  і  

і і  і і  і   .  
і   і  і    . 
 

 
 

3.8-  – ң і і і 
 

і    і    
ң і   і   :   
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 ң    і ің і 
  ;   

  і і і  ң ;   
  і   і ;   
   і  і і і   ,  

і  ң і, і і  і і, ;   
 webadmin і. 
3.9-  ң  і   і і  і  

і. 
 

 
 

3.9-  – ң   і  
 

      . 
 

 
 

3.10-  – ң   і  
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3.11-  – ң   і  
 

 
 

3.12-  – ң   і  
 
« і і»     і і  

  .  3.13-  і . 
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3.13-  – « і і» 
 

ің ң      і і. 
 

 
 

3.14-  – « і і» 
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       .  
3.15-  і . 

 

 
 

3.15-  –     
 

 
 

3.16-  –   
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3.17-  –     
 

 
 

3.18-  –  -     
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3.19-  –      
 

 
 

3.20-  –   і і ің   і  
 

 
 

3.21-  – ің    і і і 
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3.22-  – ің    і і і  і  
і  і   
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4 Э  і  

 

«Ar store» - і і     і  
і     і   .  -

, mp3, DVD і і,    і ; 
і ,  /   ің . 

  ің ң  і  (30   
  ) і  і   і і 32 . 

« », « »  і і  , -  
ің   і. 

« » і  « і і ің» (  900 ) 
  ң і і   ң і і. 

і , і ің  ің   
 . 

  «AR Store» - ің   
,   і - і   . 

І і    « »   
 і і,        

   , і і і    , 
і. 

   ің і і – і і і  і і і 
 і  і   ң   

. 
 
4.1 ғ     і  

ғ , ұ ғ   ғ  ғ  ш ғ  

 
Ш   і і    і і і    3.1 

 і . 
 

4.1-  – і        
 ң   

 
 
4.2-  –  
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    ң ің  
. ң   і      

ң і    /   - 4,09 . Ш  
4.3-  і . 

 
4.3-  –    

 

 
      

ңі ,  і       і 
.  ң і і -    
 .     і . 

1  і   ің (4.1)   і. 
 

                                                                      (4.1) 
 

,  – ің   ің  ; 
 a –   (0.2); 
 F  –  і і і  ң  (2500 )). 
 

4.4-  –   і 

 

 
 і      
  ,     12235,14 ң і . 

 
4.2 Ж  ш ғ  

 
 і   і     . 

 ң і і і   , і  
  -  ің  . 

   (4.2)   і. 
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                                                                                           (4.2) 
 

,  – ң   ; 
  –     і 

(20000 ). 
 

= 20000/168 = 119 ң  
 

 = 200 ң  –    ң   
 і і і  і і і і; 

 = 250 ң  –  і   ң  
 і. 

 і   ,  ің 
ң    .  4.5-  

і і . 
 

4.5-  – і і    і 

 
 

4.3 і  і і   

 
і ң  і   і і   , і  

 ,     . 
2019   і  (4.3)   і.  

 

                                                             (4.3) 
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,  – і ң  і  ; 
  – і і ; 
  –  . 
  = 0,30*(20360+3054) =7024,2 ( .) 

 
і і  і    : 

 
4.6-  –     

 

 
4.4 Э  і і і і ғ  

 
, - ің   і    (  і – 

)   42673,34 ң і .  
і  , - ің     

ң (  і – )    . 
  - ің  (  ) 74800 ң і 

. 
,  = 74800 –  = 74800 – 42673,34 = 32126,66 ; 

, - ің     і ің 
ң     і  . 
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5 і і ші і  і і і і 
 

   ің  ң  
і і  і і   і і і і ің ң  і  . 

  ң  і і і і  ң і  і і і і 
 , . 
і і і і  і і і і –   ң і і і і  

 , ң  ,   і і 
ң   і    і  

  і ,  ң    
 і    . і і і    
. 

ің  , ң   і і і і, 
і  ң  і  ң   ң 

 ң і і  .   
ң і  ңі   і і і, 

ң   , , і  , і і   
 і і і      і і і 

. 
  і   і   

-  і    і і . 
і і  і    і ің  

 ңі  .   і   
і і   і і і   : і  

і ,    ,   і і ,   
. .  6  (4    2 )  і і. ің  

і 5.1-  і і . 
 

5.1-  –   

 

 
 LG P09SP2 Dual INV і, HP ENVY AiO 27-b113ur 

2CW08EA (6 )   Canon i-SENSYS LBP212dw -  (3 ) 
і  . 

  і  ң -  
і,  ң  і    

 і   ң і    
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.  ң і і   і  ң ,  
ң ң     і  ң . 

   і  . ң і 
ңі  і і    і і ің і   

і   ң  ,  ің 
   і і  і і і і  . 

  і ,  і і і  
    ,   ңі -   

ң і і і і   і. і  Windows ң 
      
ңі .  ң і і і  , , 

,    і і  і і. 
 30494   12.1.005  -    

 і   і   . 
      і   . 

і ің і  ң  LG P09SP2 Dual INV і .  
 ң і і і. 

і і  ң і і і ің і і –   
і  і   ң  ң і.  ң ,  

 ,  ң і  і  ң  . 
і   ,     

ң   ,   і і і.  іңі  , 
 ң ,  , і і і , ң 
,   ің    
  . 

  Windows  8  . ің і і ,  
ң і і  і і  і.  

ің і і  і   . 
 ң   і  ң , 

ң і , ң і    і   
і .     і  

і . 
  .  і ің і і  

. ің і і і  ң . 
 

 

 
 h  = 0,5   h . .= 0,8  

 
h  = 4−0,5−0,8 = 2,7  

 
Ш ң   [3  4] 5.1-  і . 
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5.1-  – Ш ң   
 
Ш      =0.6÷2.0. 
 

L = ∙ h  =1·3=3 
L = ∙ h =1,34·3=4 

 
 і    і    d8; d7,10; d3,9; 

d2,4,6,11; d1,5 –     і   
і і  : 

 
d8=8 ; 
d1,5=3 ; 
d3,9=4  

d7,10= =   
d2,4,6,11= =5  

 
 і ің і і і  d  і і і ің  

 : 
 

tgα1 = = = 1,11 → α1 = 48°; 
299,0cos 1

3   

 
tgα2 =  = → α2 = 62°; 

103,0cos 2
3   

tgα3 = = = 1,48 → α1 = 56°; 
175,0cos 3

3   

tgα4 = = = 3,16 → α1 = 73°; 
0249,0cos 4

3   

tgα5 = = = 2,96 → α1 = 71°; 
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0345,0cos 5
3   

 
Ш  і  ң   PRS/RECOLED 300 4000KP =2*18  
 

 
 

5.2-  – 2- ң і PRS/RECOLED 300 4000K 
 

 
5.3-  –  

 
  і   5.3-    і   

 
Iα1=310  
Iα2=180  
Iα3=370  
Iα4=80  

Iα5=100  
 

і    і   - ң 
: 

 

p

АГ
h

In
е


3cos

  

;43,25
7,2

299,03102
21 


АГе        ;17,10
7,2

103,01804
22 


АГе  

;76,17
7,2

175,03702
23 


АГе        ;0,54 ,
7,2

0249,0802
24 


АГе  
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;94,0
7,2

0345.01002
25 


АГе  

 




6

1i

АГiе = 1АГе + 2АГе + 3АГе + 4АГе + 5АГе + 6АГе =25,43+10,17+17,76+0,54+0,9=54,84  

 
 : 

 









6

11000 i

АГi
л е
K

пФ
E


 

 
,  - " " ң і  і   

(1,1 ÷ 1,25). 
 

26,11684,54
2.1 1000

21060 2.1





АГE  

 
Emin = 200  3.12   ( і і і   і і і  

ң )) 
 =  min ( . .     
    ). 
 і ің і і.  і - . 

 

)( 

 

BLh

BL
i

p 


  

 

88.1
)814( 7,2

8 14





i  

 
 і  ң  5.4- ,  

,  і -   і  і : 
 

 
 

5.4-   –  і ң і PRS/RECOLED 300 4000K 
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η=70% 
 

і  і і ң  =200 : 
 

п



η 

K  ZS E
N min  

 
, Z – 1.1÷1.2 ң ң і і  і; 
  –  і, ң  1.3 і  

і  і і -  3.11 ( ң   і і і  ШІ) 
 

);(22
27.0 1060

3.1 1.1 )8 14( 200
N 




  

 
Ш ң  22-  і  . 
 

. ң і і і і і    . -
    і  Keo- ң  

і   і   ң ң   . 
Keo- ң  і eN = 0.84 і  і   і  

  і  III  і  і   і. ІІІ - 
35 2  ң . 

 ң і і і і    . 
ң і і  і ің і і і  

  і  і  ң  і  і. 
і   і ің і    

і  ң  36  і   . 
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 ң  « і    

-  »,  – і    
. 

і і  і   і  
    . , і , 

     .    
    .   і  і  

  і ің   ,   і ің 
 ,  і і.    

 і і   Visual Studio C#-  і і. 
  і   ң  

ңі і      
.   і і, і і і  

   і  і і  і   
  і  і і.  ,  і 

       
 . 
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